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The Basics

A llcr you follow the instructions in "Chapter l: Getting started" and enter the
s(iutr.lp information, you can run any of the unit's built-in applications. Before you
rkr so, read this chapter for some basic information about using the unit,s menus
rrrrrl controls, and storing records.

Using the Pen
I lsc the pen to start applications, select menus and tools, and enter information.
'lir use the pen, remove it from its slot. Then pull it to its full length.
'l'hcrc are two basic pen actions:

'lirp Selects an application, icon, menu, command, or button. you can also
cancel a selection by tapping elsewhere on the screen.

l)rag Selects text or an area on the sketch page.
'l'o select text, hold down the pen and drag it across the text. To select an area on
thc sketch page, drag the pen diagonally on the screen to form a rectangle. you
irlso drag the pen to move floating menus and file manager icons in applications.

Storing the Pen
when you are not using the pen, push it together and then insert it into the storage
cornpartment. Push the pen in all the way so it clicks, locks in place, and does not
slicle out. To remove the pen, press it in until it releases.

I l you lose the pen, you can substitute a plastic or wooden item (such as the cap of
ir hallpoint pen or a chopstick), as long as it does not have a sharp tip.
'lir avoid damaging the display, do not use:

o Any sharp object

r Metal

o Standard ink pen (ifit doesn't have a plastic cap)

r Knife

Working with Applications
All of the applications were designed to work in similar ways. The applications
include consistent graphical cues to help you work and make learning easy.
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About the Address Book
'Ihe Acldress Book is like an office card file to help you keep track of your con-

tacts. The Address Book has two views: an index of address book entries and the

address book entry view.
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lndex to names in the address book

Each address book entry view has two

Address book entry view

pages: an address page and a sketch page.

Use the address page to enter the information Use the sketch page to take noles lor the
on a contact. contact or draw a maP.

Chapter 4 covers the Address Book application in detail.
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About the Date Book
I lrt' l)irte Book works like a desk calendar and appointment book. The Date Book
lr,rs lirrr views: six-month, month, week, and day. You can move among the views
r;rrrt'kly with the tap of the pen. You can schedule meetings and have the Date
llook rcrnind you about them. You can schedule recurring events, such as birthdays
, rr rvcckly meetings. You can also keep track of important to do items.
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Each day view has three pages: an event page, a to do page, and a sketch page.

Working with Applications 19

About the Note Book
'l'lrc Note Book is a place to write notes or lists and store information. The Note
llook has two views: a table of contents of note book pages and a sketch page.

Hote Book
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El Basic Formulas - - -

EI Heating & Electrical Terms

l=.1 )5 n+b" ts

E Proofreaders Harks

E 0iacritical Harks

Table of contents of pages in the Note Book Note Book sketch page view

Yru can organize your note book pages into topics by grouping several pages
rrnder a main topic page. Chapter 5 covers the Note Book application in detail.
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Use the Evenl page to plan your day.
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Euent @fsketchJ

Use the To Do page to make a list of to do
ilems lor the day.

Chapter 3 covers the Date Book application in detail.

Use the Sketch page to take noles for the day
or draw a map to a meeting.
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Note Book sketch page view
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About Pocket Quicken
Pocket Quicken lets you keep track of where your money goes. Pocket Quicken
has three views: wallet, bank, and file cabinet.

Bank view to record deposits, transfers, and
withdrawals

File cabinet view to see account registers

Chapter 6 covers Pocket Quicken in detail.

:king 882.01
tercard 272.85

666.42

Ig*ffi]tffi*@-l
I ttennsil I I Hathdraual I

@€Elpffiml
I Transfer I I Neu Hccount I

FaUment l"lethods

Wallet view to enter transactions

Starting Applications and Accessories 21

Starting Applications and Accessories
I lrr'r'c arc three ways to enter applications and accessories. You can:

o 'lirp one of the fixed application icons at the bottom of the display.

o 'lirp the Launcher fixed icon to display the application menu..

lap the Launcher fixed icon
to switch to another application.

(io to the File Manager and select an application or file to open.

Tap an icon or lile twice lo slart an
application.

Scc Chapter l0 for detailed instructions on using the File Manager.

( )rrce you open an application, you can enter your information or view reference
irrlilrrnation. The information is saved automatically, even if you turn off the unit.
'l he unit also remembers where you were in an application when you turned it off.
'l hc next time you switch the unit on or return to an application, it takes you to the
sirrrrc location.

aIa
o
U
I
F
N
Io

ERHA LI\CEOHORKS\HORLO

rur
RElerence Utilitier America of,line

l=r{+t lftEl/ trj.B\E rs-af '-'r
tri+lionar! Form EilculatrrLinquBqe Tra...



2322

7z

The Basics

Fixed Icons
Certain icons (called fixed icons) always appear along the bottom ofthe screen.
These provide access to features and applications no matter where you are.

Choosing from Menus

l\losl rncllll choices represent commands. Others represent settings that can be
rrtlrt'r'on or off. These items have special symbols that indicate whether they are
otr ol ol'l'.

To

Display a menu of applications

Open the Address Book application

Open the Date Book application

Open the Note Book application

Open the Pocket Quicken application

Display the World Clock

Display the Calculator

Display a floating menu bar

Show or hide the on-screen keyboard

Display help

Name

Launcher fixed icon

Address Book fixed icon

Date Book fixed icon

Note Book fixed icon

Pocket Quicken fixed icon

World Clock fixed icon

Calculator fixed icon

Menu Bar fixed icon

Keyboard fixed icon

Help fixed icon

lt ll0

't t1U.l0

|[ilt)
ll00
ll' tlIJ' lr00

I00
:'00
r t)0

4U0

!i tl0

lr 00

This item is turned on.

This item is turned off.
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/ 00. s:r' 5 af_l ball

Tnp a menu name to open a menu and tap a
rnonu choice to select it.

Displaying the Menu Bar
ln thc applications, the menu bar provides commands you can use. You can show
llrc rnenu bar in one of two ways:

o As a floating menu bar you can move or hide to save space on the screen

o As a permanent menu bar displayed at the top of the screen

'lirp the Menu Bar fixed icon to display the menu bar.

Choosing from Menus
Most of the tasks and commands you need are available on the screen as buttons or
icons. The menus include additional commands and options. Menu names appear
in the menu bar. When you tap a menu name, the menu itself appears. Some menu
choices appear dimmed (light gray), which means that they're unavailable for use.

Some items become available only after you make a selection.

Preferences...
I Shou, Emptu Times
I Shotu Euent Duration
tr Shour Ell To llo's
Text 5earch...
Go To OaU...
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HetU Entrg.,.
0uplicate EntrU,..
Delete EntrU

The floating menu bar.

I{etU Entru...
Duplicate Entrg.,.
Delete EntrU

applications:

Button or Control

)

{

The Basics

The menu bar floats on the screen, which means you can move it where you want

it. You select the menu item you want and then hide the menu bar.

Tap lhe Exit icon to hide the menu bar.

Tap and drag here to move the floating
menu bar.

Tap this bution to keep the menu bar at the
top of the screen, so that it is always
available.

The menu bar is now always available until
you hide it again.

To hide the permanent menu bar, tap the
Menu Bar fixed icon.

The permanent menu bar.

Using Controls
The following table lists the navigational buttons and controls common to most

tiutton or Control What lt Does

| ;Nme--= Opens a pop-up menu (a list of items),
which you can then select.

I,,,,u!iil Displays a submenu for the menu item

EE@ Move between views in applications.

Entenng lnformation

Name

Pop-up menu control

Submenu control

Tab

25
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l':rch application has additional buttons and controls, which are explained in the
;r; rllropriate chapter.

Entering lnformation
( )rr a sketch page, you enter information directly on the screen. Just draw or write
ilrcnlos as you would on a piece of paper. In the Address Book entry view or Date
lkxrk day view, you enter information through dialog boxes.

ln the Date Book day view, you enter event ln the Address Book entry view, you enter
lnformalion throush the Edit Event dialos box. 

;ijl:Tl#:rr"tion 
throush the Edit Fietd

You enter information in one of three ways. You can:

o Type using the on-screen keyboard

o Print with the pen and have it converted to typed characters (called handwriting
recognition or PalmPrintrM)

r Write with the pen and leave the information as you wrote it (called ink or
PowerlnkrM)

What lt Does

Moves to the next page.

Moves to the previous page

Name

Right arow

Left arrow

Moves back one level (from month to six- Exit icon
month, for example) or hides an element
(such as the keyboard or floating menu bar).
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You can use Powerlnk or typed characters when and where you want in most

applications. You decide what you want to use. From the dialog box you can

always convert Powerlnk to text later.

You enter information onto sketch pages or in areas called fields. For example, you

use a field in the Address Book when you're entering the name, address, and

phone numbers for a contact. You also use a field when you're entering infor-
mation about a scheduled event in the Date Book.

The following tools appear on sketch pages and some dialog boxes. First, you

indicate that you're entering information:

To Enter Text Then

Tap the Text tool to use the keyboard. Tap the Keyboard fixed icon, and then
tap the keys with the pen.

Tap the Text tool to use the pen and Print with the pen; each character you
handwriting recognition. print is recognized.

Tap the Ink tool to use the pen. Write with the pen; your ink, called
Powerlnk, is left as is and shrunk
down to fit on the page or display.

Typing with the On-Screen Keyboard
You use the on-screen keyboard iust as you would a typewriter or computer key-
board, except you tap the keys with the pen. You tap the Keyboard fixed icon to
display the on-screen keyboard.

Tap the Exit icon to hide the keyboard.

Tap the keys to enter text.

Note: Ifthe keyboard appears gray, you cannot use it to enter text. This occurs

when:

r You need to tap the pen in the text area to indicate where you want to enter

the text.

o You may be in a field but the Ink tool is currently selected. Tap the Text tool
to make the keyboard available.

Enteringlnlormation 27

Switching Keyboards
Whcn the keyboard is selected (black), you can switch the keyboard type. Tap the
rrppcr right corner of the keyboard to select from these types.

Kcyboard Standard qwerty (typewriter-like) keyboard in the current language.

Alphabetic Letters displayed in alphabetic order

Symbols Common symbols such as bullets, copyright, percent, dollar sign, etc.

lrtlernational Characters with accents, umlauts, tildes, etc.

Math Symbols Plus, minus, equals, square root, etc.

Writing Grid The unit converts each character you write into letters on
the screen.

Sclcct the desired keyboard and tap the letters and symbols to enter them.

Using the Writing Grid
Whcn you select the writing grid keyboard, you write each character in a box and
lltc unit converts it into a letter on the screen. Blank boxes between letters translate
irs spaces between typed letters or words.

You use these controls to display boxes for additional characters and to move
rrlong the writing grid.

Button What lt Does

Moves to the beginning of the boxes

Moves the boxes back one screen

Moves back one box

Moves forward one box

Moves the boxes forward one screen

Moves to the end of the boxes

Enters the insert mode

'lir change characters, simply write over the previous one in the box. To insert
characters, tap the insert button so it is highlighted on the screen and then write
over the character where you want to begin inserting.
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The Basics

Using the Pen and Handwriting Recognition
You use handwriting recognition when you want to use the pen to store and

display what you print as typed characters.

Tap the Text tool to tell the unit to recognize
your printing, then print with the pen. Your
ink is converted to text.

Writing with the Pen

You use Powerlnk when you want to write or draw with the pen and you want to

keep what you enter as it is. You can use the pen both on the sketch page and in
fields.

Tap the lnk tool to specify that you're going
to enter ink. Your ink will be left as you
wrote it.

Note: If you enter ink into a field, your pen markings are left intact and

aren't converted to text. Later, you can convert your ink into text by tapping

the Text tool.

Enteringlnformation 29

Handwriting Recognition Tips
'l'he unit recognizes hand printed letters and numbers. You can enter hand-printed
t haracters in text fields or on the sketch page. When you use hand-printed char-
;rclcrs in the field or on the sketch page when the Text tool is active, your hand-

lrlinted characters are converted into typed characters.

'l'lrc lbllowing tips will help the unit to recognize your handwriting:

Print each letter or number clearly. Each character needs to be clear enough to
bc recognized. You can use upper or lower case letters.

Keep your letters upright. Try not to write letters with a slant.

Use as few strokes as possible in writing a letter.

Make sure you keep the pen on the screen as you write-you don't need to
press down hard, but you don't want to hold the pen so lightly that it doesn't
rnake good contact with the screen.

Don't write too slowly.

Print large characters. You can use the whole dialog box.

If the position that the ink appears on the screen doesn't match the position of
the pen, you need to recalibrate the pen. See Chapter I L
'lb write several words, write one below another so that the unit inserts spaces
between the words correctly.

Some characters are so similar they can't be distinguished by the computer-
characters such as Z andZ, S and 5, O and 0, and I and 1. The following table
shows how to make each character clearer.

a

a

a

a

a

a

Writing the Z with a slash through il

Writing the 5 in two strokes instead
of one

Writing the 0 (zero) with a slash
through it

Writing the 1 with a line under it

ZZ
sJ
,fr
,l
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The following table shows characters that can be successfully recognized by the

computer and those that could not be recognized:.

Char. Successful Unsuccessful Comments

^ A,qAAA {+A
" :r3fi13 B

a

Can be confused for the number 6.

Can be confused for a lowercase "I",
or the number I if surrounded by other
numbers.

.CC, lDm, ze rt_ El=-\;
' [E - FC $GGGG6, $l-tt+t^l' lr, J,J- Kr(
Ll_
, Ynr,4 mmrl"l
,.NT\ NNI\I
"(J
" FPt,
"GQ- Rf,.RR
'5r -l-T t,tu
, V\/
w W W\,./
xI
' YYY )'.ZZ

t{H

K
t*

a

\J

Z 
Can be confused for the number 2

Enteringlnformation 31

Unsuccessful CommentsChar. Successlul, d,a
h lb tbrb
. ec
d /dtc[ 1dr.g,f+,qi
n th rli
' it.
I JIJI
*'l('l<
,rl I
n 16TltV|1
n rh t/l'oo-
, 'f ,fl'P
0"6
'1rr.5
tt
' l\Jll-A
" qul'\f
* JWW
xN
, YY.ZZ

I
ao
o
o
Urt
N

e
dt
t-

Must be dotted.

Can be confused for a capital "[', or
the number 1 ifsurrounded bv other
numbers.

Can be confused for the number 2.

K

1
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Char. Successful,lt 
I,12

,33
'4 t
'55
'"6',b
'777
'tg
'12,fio

period, decimal

space 
-

Can be confused for the letter "S"

Can be confused for the letter "O".

Make a small round mark, do not just tap

the screen. (used in numeric fields only.)

The double-underline space symbol must be

written at the baseline. You must write the b

in a single stroke in order for the unit to
recognize ! as a space. You can also get a

space simply by leaving a space between
words when you write.

Plus, equals and divide are recognized in
the calculator only.

Example

To

Select a word with the
pen

Select more than one
word

lrrase a selected word or
words

Insert text within
cxisting text

Insert text in a text field
aiter existing text

Do This

Quickly tap the word rwice.

Hold down the pen (pause for
a moment) and drag it across
the words.

Draw a vertical line up
through the selected text and
put a loop or pigtail at the end
(called the pigtail gesture).

Tap the pen where you want
the next character to go. Then,
write the character or word
somewhere in the text field or
screen.

Write the next characters;
what you enter gets added at
the end of existing text.
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Example

sebcEd[@

more than o*EEI@E@

lt
delete au,urd9iE

insert acharf:br A

dd characbrsl, thd E n d

b
777

T

o

o

+plus

WM
Using the Sketch Page
lrr the Date Book, Address Book, and Note Book, you use a sketch page to draw,
rrake handwritten notes, or enter text. You can enter text using the pen, hand-
writing recognition, or the on-screen keyboard. Think ofthe sketch page as having
lwo layers: what you write or draw with the pen (ink) appears on one layer; text
you enter with the on-screen keyboard appears on another layer. The sketch page
tlisplays up to 170 lines oftext, but can only print the first 60. For ink entries, this
is cqual to about 3 screens.

ft Aa*ive Sire of Flands a ()

Mercury
Venus

Earth

Mars

Asbroijs

Jupiler

Saturn

The sketch pages in the Date Book, Address
Book, and Note Book are identical.

,???llTt?

To

Enter a space as you're
writing

Do This

Leave a space between words
as you write, or if using
handwriting recognition,
write a "space character"
(two short horizontal lines).

Unsuccessful Comments

I 1 Can be confused for a capital "l" or a
J -L lowercase "l".

2ol
a

equals :

divide _-

The unit recognizes "-" as a minus sign tn
the calculator and as a hyphen elsewhere.

newrine ._-lt

Pen Gestures

When you write or edit with the pen, certain gestures have special meanings. The

following table explains these gestures.

a
(t)

o
U
I
F
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Eea*iu"simofPlurds 4 { }
x ll e llfi I lneur

lnk tool

Text tool

Clear

Backspace

Tool box

2 To enter ink, tap the Ink tool, and then draw ink. Tap the Tool box to display

more sketch tools.

See the next section for information on using the sketch tools.

3 To enter text, tap the Text tool.

After tapping the Text tool, you can use the on-screen keyboard or handwriting

recognition to enter text. Whatever you print with the pen gets converted to text.

4 Tap Backspace to erase the last letter or ink segment you entered.

Using Sketch Page Tools
The sketch page includes tools for entering text using the pen, keyboard, or hand-

writing recognition (see "Entering Information" earlier in this chapter). The sketch

page also provides sketch tools you use to draw or edit text and ink. Display these

additional tools by tapping the Tool box icon. The following table describes the

bketch tools.

Tap To

Display the sketch tools

Write or draw in ink with the pen

Erase by hand (as if using a pencil eraser)

Select a portion of the sketch page (drag the pen to

select)

Cut (delete) the selected portion of ink or selected

text

Copy the selected portion of ink or selected text

Paste the cut or copied portion of ink or selected

text (must cut or copy something first)

Zoom in on the selected portion

tr
tr
ffi
tr
tr
tr
@
E

Name

Tool box

Sketch pen

Eraser

Select tool

Cut icon

Copy icon

Paste icon

Magnify In

The Basics

To use the sketch page:

1 From the Note Book table of contents, tap the page you want to use. In the Date

Book, display the day view and tap the Sketch tab. In the Address Book, display

the entry page and tap the Sketch tab.

E
E
tr
tr
E

Using the Sketch Page

Name

Magnity Out

Exit icon
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I ill)

l,{
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To

Return to normal size view

Hide thc skctch tools

llalrtg the Sketch Tools tor lnk or Text

\ r ril ('iilr cut or copy an item, and then paste it somewhere else on a sketch page.

\'o11 f i111 also magnify an area for editing or adding details.

1,, r'ttt ot' copy and paste an Ink item:

| 'lhp the Ink tool.

2 'lirp the Tool box to display the sketch tools.

:l 'l lp the Select tool.

4 I )r ag the pen diagonally to draw a boundary around the ink you want to edit.

lruagine a rectangle for the area you want to select. Start at one corner ofthis
irnaginary rectangle. Drag the pen on the screen diagonally until the rectangle
is the size you want.

Drag the pen to make a selection.

5 Tap the Cut tool to remove the item, or tap the Copy tool to copy the item.

6 Display the sketch page where you want the item to go.

7 Tap the Paste tool.

I Tap where you want the item to go.

I
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To cut or copy and paste a Text item:

1 Tap the Text tool and enter the text.

2 Hold down and drag the pen across the text you want to edit.

3 Tap the Tool box to display the sketch tools.

4 Tap the Cut tool to remove the item, or tap the Copy tool to copy the item.

5 Display the sketch page where you want the item to go.

6 Tap where you want the text to go.

To paste the text within existing text, tap where you want the text to start.

The text is pasted after the cursor.

7 Tap the Paste tool.

Note: If you paste text which exceeds the 17O-line display limit, the text which
exceeds 170 lines will not be displayed, though the hidden text remains stored
with the page. To reveal the hidden text, cut visible text from the page and paste it
on another sketch page.

To magnify an area:

1 Tap the Tool box to display the sketch tools.

2 Tap the Select tool and drag the pen diagonally to draw a boundary around the
area you want to magnify.

3 Tap the Magnify In tool to magnify the selected area.

You can add text or ink in the magnified area.

4 Tap the Magnify Out tool to returx to normal magnification.

Copying or Cutting a Whole Sketch Page

You can copy or cut everything on a sketch page (including all text and ink) at

once. Then you can paste the whole page on another sketch page in the Date Book,
Note Book, or Address Book.

Note: Pasting a whole page onto another sketch page replaces the contents of the
destination sketch page.

To copy or cut a whole sketch page:

1 Display the sketch page that you want to copy.

2 Tap the Menu Bar fixed icon to display the menu bar.

3 Choose Copy All or Clear All from the Edit menu.

If you choose Clear All, you see a message asking you to conflrm the deletion.

4 Display the sketch page where you want the information to go.

Managinglnformation 37

5 ('lroose Paste All from the Edit menu.

ll sornething already exists on the sketch page, you see a message warning you
lhat the contents of the sketch page will be replaced. Select Yes to replace or No
Io cancel.

Managing Information
A tkrcument is a group of related information you store in an application. For
t'rrrrnple, in the address book, you could create two documents: one for personal
,rtlth'csses and one for business contacts. Documents let you retrieve information
',(, y()u can view or edit it.

llrc lirst time you start the unit, you begin with a new document in each appli-
t'rrlion. After you have created documents in an application, you return to the last
rkrcurnent you worked on when you quit the application.

l'lrcre are two basic ways to access documents and display information about doc-
unrcnts: using File in the menu bar or using the File Manager. Chapter l0 covers
tlrc lrile Manager in detail.

Note: In the Note Book and Address Book, you can also switch documents by tap-
pirrg the document title in the index view. See Chapters 4 and 5 for more details.

Using File in the Menu Bar
lrilc allows you to switch documents, start new documents, display document
irrlirrmation, and print documents. It also displays information about the current
rrpplication.

lit tlisplay information about the current document:

1 Tap the Menu Bar fixed icon to display the menu bar.

2 Tap Info on the File menu.

A dialog box appears that includes the document name, the document size,

the total amount of memory the document uses, and other system information.

3 Tap OK to close the box.

'lit .start a new document in an application:

1 Tap the Menu Bar fixed icon to display the menu bar.

2 Tap File.

3 Tap Switch Document.

4 Tap New to create an empty document.
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To switch from the cunent document to a previous document:

1 Tap the Menu Bar lixed icon to display the menu bar.

2 Tap File.

Tap Switch Document.

Tap Open.

The Open dialog box appears. You can select these options from the box.

To open a document, tap the document name then tap Open.

To switch to the Advanced box, tap Advanced.

To cancel and return to the current document, tap Cancel.

Note: The Simple box only displays a list of documents. The Advanced box dis-
plays more detailed information about directories and drives. See "Chapter l0:
File Manager" for more information.

To display information about the curent application:

1 Tap the Menu Bar fixed icon to display the menu bar.

2 Tap the last menu item ("About Notebook/Address Book/etc.")

A box appears that shows the release date and version.

3 Tap OK to close the box.

Searching for Text
You can quickly search through a document to find a word. For example, in the
Address Book, you can search for a company name and then you can jump to each

entry for people who work at the same company.

Notes:

The unit only searches for text entries. You cannot search ink entries.

Text Search in Date Book does not find repeating events or to do items.

To searchfor text:

1 Open the application and document you want to search.

Tap the Menu Bar fixed icon if necessary to display the menu bar.

Choose Text Search from the Options menu.

You see a dialog box where you enter the word you want to find. You can use

the keyboard or handwriting recognition.

4 Enter the name you want to find.

You can use special characters to help find the word. Tap the Special Characters
pop-up menu and choose Match Multiple Characters or Match Any Character.

Using the Memory

I lsc the Asterisk (*) to represent several characters. For example, Smx finds
Srrrith, Smythe, and Smothers. Use the Question mark to represent one char-
rrclcr. For example, 2?3 finds 213 and 203.

5 lirp Find Next to find the text.

lir rg1s1s6 for the same text in a different application, tap that application's fixed
rr orr. thcn select Text Search frorn the Options menu. The text you were searching
lrrl irppcars in the dialog box.

Using the Memory
l'lrt: unit has a I megabyte memory: 352K is used for infbrmation storage (user,
;rpplication and system information) and 640K is used to run the applications. The
innount of space for information storage varies, depending on how much and thc
lypc of information stored, but the 640K memory for applications cannot be
t luurged.

l'lrc lbllowing sections explain how the unit uses the memory to run applications
;rrrtl provides some tips for maximizing the amount of information you can store.

Running Applications
Not all of the applications can fit in 640K at once, so the unit only keeps some
rrpplications in open memory while others are closed.
'l lrc unit can usually hold two or three applications in memory at a time. If,
Iror.vever, you open another function that is not currently in memory, the unit must
t losc one of the three to open the new f'unction. You see a message that the unit is
rrctivating the function, and it takes several seconds for it to open.

Alicr you have used the unit for the first time, it opens the most recently used
irpplications. The number of applications it can open depends on the size of the
rrpplication. For example, if you last used the Date Book and Pocket Quicken, the
trnil opens those applications when you power it on.

Information Storage Tips
ll'you see the message that your information storage memory is running low,
lirllow these suggestions to free some memory.

o Writing with the pen takes up to ten times more memory to store than text
entered with the on-screen keyboard. You can convert your handwriting to text.
(See "Entering Information" earlier in this chapter.)

o Purge the Date Book of old information.

r Purge Pocket Quicken ofold transactions.

o Purchase a PCMCIA information storage card for extra information storage.

39
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Using Help
You can get help on all the functions of the unit.

To display help:

1 Tap the Help fixed icon at the bottom of the screen.

Depending on where you are when you tap the Help icon, you see one of the

following:

r A list of topics for the current application

r A help screen for the particular function you're using

2 To see a specific topic, tap the topic name in the list.

If the contents of the help doesn't fit in the help screen, scroll bars appear.

3 Tap the down arrow to shift the contents of the help screen to reveal more of the

help.

Some help screens have links to other topics. Tap an underlined word or phrase to
jump to help for that topic. Other topics appear under the section "Related Topics"

at the bottom of the help screen. Tap a related topic to jump to help for that topic.

To display a list oftopicsJbr the current application:

r From any help screen, tap the Contents button.

To retrace your step,s through the help screens:

o From any help screen, tap the Go Back button.

To display a list of the help screens you've viewed:

1 From any help screen, tap the History button.

A list of the help screens appears.

2 Tap the name of the help screen you want to view.

To t'losc the help screen:

o Tap the Exit icon.

Covered Elsewhere
Printing in Chapter 12

Sending and Receiving Pages in Chapter l2
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